
Layout Application User Guide

This document covers the basic drawing and layout features of the ReportMill page layout 
application. Advanced users may want to save this document for last, since it merely covers features 
common to many page layout applications.
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Overview

ReportMill is unique in the world of report writers in that its foundation 
is a very powerful and easy-to-use page layout application. Some of 
ReportMill's advanced layout features include: Rich text editing, 
powerful drawing tools, advanced image support, advanced graphics 
transforms, textures & gradients, undo, page layering, rulers, grids, 
guides, shape grouping, shape ordering, multi-page templates, 
animation and much more.

Using a page layout paradigm has many fundamental benefits:

� Instant Familiarity: Because most developers are familiar 
with page layout tools, such as PageMaker, Illustrator, MacDraw, etc., 
it easy to get started or delegate basic template design to end-users or 
other non-developers.

� True WYSIWYG Editing: Because all reports are layed out 
in a page context, its easy to quickly configure page headers/footers and 
cover/summary pages - and they appear exactly as they will in the final 
report. Even tables remain in the page context, so its possible to have 
multiple tables or tables and graphs on the same page.

� Uniquely Advanced Layout: Because ReportMill's advanced 
reporting features are implemented on top of powerful layout tools, 
there are many options available to report designers that few report 
tools offer, such as page layering, advanced graphic transforms, 
textures and gradients, etc.
        

Overview
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Overview
The primary interface in ReportMill is the Editor window.

Preview/Edit button
This button toggles between preview mode and edit mode. It doesn't do 
much until you bind your document with an XML file and start adding 
text keys, tables, etc.

Toolbar
Here are the list of tools you use to create and edit shapes. From left to 
right they are: Selection, line, box, oval, text, polygon, pencil, table, 
graph, labels and crosstab.

Page Navigation
These are simple controls for moving page forward, page back or going 
to a specific page number (just type it into the field and hit return).

Page Body
This is the actual canvas of your report, where you will add toolbar 
elements.

Preview/Edit Button

Tool Bar

Page Navigation

Page Body

The Editor Window
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Overview

ReportMill tries to do as much as possible through "direct 
manipulation" in the document window. However, many of 
ReportMill's more sophisticated settings can be found in the inspector 
panel. Here is a break down of the parts.

The Selection Path

The first row of icons in the inspector is the "Selection path". 
ReportMill provides for deep editing of the document heirarchy: you 
will frequently be editing a Text Field, inside of a Table Row, inside of 
a Table, inside of a Page inside of the Document. Each of these 
elements offers its own inspector, which you can easily access by 
clicking on its icon in the Selection Path.

Notice, there are fewer icons when the heirarchy is more shallow,
such as when a text field is a direct child of the page (then you have 
Document > Page > Text Field).

The Inspector Mode

The second row of icons in the inspector is for choosing the specific 
type of attributes you want to edit. The first one is the "Shape 
specific" and the most commonly used mode. The remaining modes 
are:

� Fill/Stroke/Effect
� Placement/Transform
� Binding expressions/Misc
� Animation

Selection Path

Inspector Mode

Document Page Table Table Row Text

Shape 
Specific

Fill/Stroke/
Effect

Placement/
Transform

Binding/
Misc

Animation

The Inspector Panel
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Showing the Document Inspector
The document inspector is available by selecting the first icon in the 
selection path.

Paper Size
You can set the page size either by directly entering page dimensions 
(in the currently selected units) or by selecting a common paper size 
from the Paper Size pick list (Letter, Legal, A5, etc.).

Units
Inspector fields having to do with size can be configured to display and 
set values in a number of different units. The default is "printers points" 
(there are 72 points per inch). Also available are inches, centimeters, 
millimeters and picas (12 points).

Orientation
Page orientation is  really a factor of whether a page is wider or taller. 
However, this control offers a quick way to swap horizontal and 
vertical dimensions.

Margins
Margins really just provide a hint to the template designer of how much 
space to leave on the edges of a page for the purposes of aesthetics and 
to avoid having page elements get chopped off by a printer or covered 
by a reader's fingers.

The Document Inspector
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Document Inspector (Continued)

Grid
As a convenience, the page designer can configure a grid to appear in 
the background of the page. With the "Snap" option turned on, page 
elements are automatically snapped to grid boundaries. By default the 
grid is configured to 9 points (1/8th of an inch).

Page Layout
By default, the page designer shows a single page at a time. However, 
when designing a book or other document that prints to a page front 
and back, it is useful to show pages side by side.  Double Page shows 
pages side by side starting with page 1 on the left. Facing shows pages 
side by side starting with page 1 on the right (this is more like a book). 
Continuous shows pages above/below.

String for Null
In the course of report generation, sometimes provided key chains may 
resolve to "null" (data that is not available). This field show the string 
that is used in these cases and defaults to "<NA>" (not available). 
Another common value is just an empty string. Note that individual 
fields may also have a formatter provided and formatters have their 
own setting for String for Null (but default to the document setting if 
not set).

The Document Inspector
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Document Inspector Advanced Options

Paginate
The Paginate switch determines whether the document is split into 
multiple pages or grows when there is more data than can be fit on a 
single page. This is a 3-state switch that defaults to "not set" so it is 
really determined when the developer calls the generateReport() 
method (which itself defaults to true).

Compress
This determines whether reports generated from this template should be 
compressed (like in PDF). Turning this switch off is really only useful 
if the need arises to debug a resulting PDF file.

Proximity Guides
This switch determines whether the editor will draw transient grid lines 
when components are created, moved or resized to indicate when they 
line up with other components around them.

The Document Inspector
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Overview
You may have noticed by now that there is a common "Attributes" 
panel for Keys, Colors, Fonts and Formatters. This panel provides 
one-stop shopping for all of these common attributes. The tabs make 
each of these panels very accessible, however, they can also be called 
up by using their menus in the "Tools" menu or their menu accelerator 
keys.

Keys Browser
The first tab in the attributes panel is the Keys Browser. This browser 
allows you to select keys from the data source for the XML dataset file 
dragged into the document. The browser shows the dataset object 
graph, which means you can navigate to all the attributes, relationship 
objects and relationship lists. Items at all levels can simply be dragged 
out.

Attribute Keys

Attribute keys are plain keys shown with no trailing arrows. If they are 
dragged in, they result in simple text fields.

Relation Keys

Relation keys are shown with a trailing arrow and show the attributes 
and relations of the object they point to when selected. Relation lists (or 
"to-many" relationships) are shown with a double arrow.

Aggregate Keys

Aggregate keys are shown at the bottom of relationship lists and let you 
easily select a key for an aggregate calculate, like: <NA>.

The Attributes Panel
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Color Panel
The color panel has a number of advanced controls for easily and 
precisely selecting colors from a spectrum, via RGBA color sliders, 
gray scale slider, Hex value or pantone set. It has a color dock to park 
common colors for easily retrieval.

Font Panel
The font panel provides user friendly controls for selecting fonts, sizes, 
and styles.

The Attributes Panel
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Format Panel
The format panel lets you configure number and date formats for keys. 
Simply select a text box that contains a key, or click on an individual 
key (<NA>) in a text box, then choose either the number or date format 
tab button. Select the first "No Format" tab button to remove a format.

Number Format
The number format tab lets you select from some common number 
formats and also lets you directly enter formats as specified in the Java. 
DecimalFormat class/javadoc (java.text.DecimalFormat).

The String for Null text field allows you to enter a value to be displayed 
in the event that the format is asked to format a "null" value (no value 
was provided). There is also an option to show negative values in red.
 

Date Format
The date format tab lets you select from a number of common date 
formats and also lets you directly enter formats as specified in the Java 
SimpleDateFormat class/javadoc (java.text.SimpleDateFormat).

The String for Null text field allows you to enter a value to be displayed 
in the event that the format is asked to format a "null" value (no value 
was provided).

The Attributes Panel
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Gallery Panel
The Gallery panel lets you add application components to a template. 
Application components can be used in templates which are viewed 
using the ReportMill viewer (available when the Preview as Applet 
option is selected from the pull-down menu next to the "Preview" 
button in the editor.

This is a feature in progress and is mostly for use with the ReportMill 
DataBox product, which allows users to design pages, forms, reports, 
datasets and queries. See the DataBox link on the front page of 
ReportMill.com for more info.

The Attributes Panel
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Overview

ReportMill has a very powerful selection model, allowing you to "select 
deep" into the report hierarchy. For instance, if you group two rectangles 
together, you can still select the individual rectangles by double-clicking 
on the group.

Super-Selected

In addition to normal selection, certain shapes can be "Super-Selected", 
by double-clicking them, which puts them in an editing state. Text is the 
most common of these. When it's simply selected, you can move and 
resize the text box. When it's super-selected, you can place the text cursor 
or select a range of characters and insert or delete text. Polygons and 
pencil shapes can also be super-selected, revealing additional handles for 
vertices and curves.

Multiple Selection

You can easily select multiple shapes by clicking and dragging the mouse 
over a range of the document. Everything the selection rect touches 
becomes selected.

Shift Selection

If you hold the shift key while making a selection or dragging a selection 
rect, ReportMill will add or remove shapes hit by that action from the 
current list of selected shapes. This is a convenient way to select specifc 
shapes when many of them are close together or over-lapping.

Shift Drag

Dragging shapes in the current selection will be constrained to either the 
horizontal, vertical or 45 deg diagonal axes when the shift key is held 
down (ReportMill automatically detects the dominant trend of your drag). 
This is a convenient way to move shapes while preserving a particular X 
or Y setting.

The Select Tool

Selection in Action

Selection
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Overview
ReportMill's text editing is very powerful, allowing for mixed fonts, syles and colors 
in the same text region (and even keys, as shown in later documents).

Text editing is very straight forward. Simply double-click the text box you want to 
edit, position the cursort and start typing.

The text inspector provides controls to set horizontal alignment (left, center, right), 
vertical alignment (top, middle, bottom) and line height (min, max or exact).

The inspector also provides a region to edit text directly in the inspector. This can be 
useful for small text fields in report templates that contain more text than can be 
shown in edit mode. This can be particularly true for fields with substitution keys (eg, 
"<NA>") or for fields that grow to fit substituted text (true for most table row text).

Rounding
This thumbwheel allows you to set the rounding radius for the text border. It's 
immediately reflected in the editor window for convenient adjustment.

Overflow Behavior
Text can be set to paginate (for form letters), "shrink text to fit" for static text boxes 
that may receive arbitrarily long text, or "grow" for text fields in table rows (which 
can grow to accommodate large text blocks).

Always Show Border
This setting just draws a grey border around text, even when not selected. Sometimes 
useful as a visual que while editing, without marking generated reports.

Coalesce Newlines
This is also useful for substitued data that might contain missing keys, eg, 
"<NA>\n<NA>\n<NA>\n<NA>\n<NA>". Coalesced newlines will make sure text 
uses the minium lines necessary.

Tab Stops
If you turn on rulers for the editor window (Tools->Toggle Rulers menu), you will 
notice that it shows tab markers while editing text. These can be dragged and reset to 
change the tab stops of the text field.

Text Editing
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Overview

The drawing tools all follow the expected paradigms.

Line, Rect, Oval

For these basic drawing tools, simply click and drag to create. The Rect 
inspector lets you set rounding radius and the oval inspector lets you 
select sweep angle and start angle.

Polygon

The polygon tool lets you click points which it joins with straight lines. 
Alternatively, you can click-drag-release, to position line segments 
interactively. If you hold down the alt key while adding points, this tool 
will behave like pencil for added segments. Editing stops under these 
conditions: clicking the same point twice, clicking close to the start 
point or clicking a new tool in the tool bar (like select).

Pencil

The pencil tool lets you click and draw free-hand path segments, 
automatically smoothing the curve on mouse up. If you hold down the 
alt key, it will behave like polygon for added segments. Editing stops 
under the same conditions as polygon.

Vertex/Curve editing

Double-clicking a polygon or pencil shape will display additional 
handles for vertext adjustment or curve editing.

Drawing tools
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New
Creates a new empty document

Open
Brings up open panel to open exisiting rpt files.

Close
Closes the current open document.

Save
Saves the current open document (bring up a save panel if untitled).

Save As...
Brings up a save panel to choose a filename and save the current open 
document.

Revert to Saved
Reloads the last saved copy of the current open document.

Export
Allows you to save the current document as PDF, Flash or Flash with an 
HTML container file. There is also an option to FTP the exported file to a 
website (it determines file type from extension: pdf, swf or html).

Preview Report
Same as hitting Preview button in Edit window.

Preview Reports
Brings up preview in PDF viewer, Flash viewer or CSV viewer.

Samples
Brings up some sample documents for tables, graphs etc. Also has several 
XML files, which get saved to TEMP folder and opened in IE.

Quit
Exits application.

The File Menu

Page 15 of 21



Undo

Undoes the last action.

Redo

Re-does the last undo (assuming nothing was changed after the last 
undo).

Cut/Copy/Paste

Allows you to easily duplicate or import document elements using the 
system clipboard.

Select All

Selects all elements at the current level of selection (or all text, if 
editing a text field).

The Edit Menu
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Font Panel...

This brings up the Font Panel tab of the Attributes panel.

Bold (Italic, Underline)

This turns currently select text (or text fields) bold (or italic or 
underlined). This functionality is also available in the font panel.

Align Left, Center, Right

This aligns currently selected text (or text fields) to the left, center or 
right. This functionality is also available in the Text inspector.

The Format Menu
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Add Page

Adds a page to the current open document, after the currently selected 
page.

Add Page Previous

Adds a page to the current open document, before the currently selected 
page.

Remove Page

Removes the currently selected page in the current open document.

Zoom In/Out

Increases/decreases document zoom by 10%.

Zoom 100%/200%

Zooms to the specified percent of actual document size.

Zoom Toggle Last

Zooms to the last specified Zoom. 

Zoom...

Brings up a zoom panel that allows you to exactly specify a zoom as a 
percentage of actual document size.

The Pages Menu
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Group/Ungroup

Allows you to merge the currently selected shapes into a single shape 
for convenient management. Contained shapes are still accessible, via 
double-click super-select. Ungroup separates shapes grouped in this 
manner.

Bring to Front/Send to Back

All shapes have an order on the page that determines what is drawn on 
top when two shapes over-lap. These options allow you to alter that 
order.

Make Row Top/Center/Bottom

This feature allows you to quickly align several shapes in a row, either 
by their top border, their center or their bottom border. The different 
options are provided because shapes may be of different heights.

Make Column Left/Center/Right

Same as above, but for columns.

Make Same Size/Width/Height

This feature allows you to quickly make several shapes the same width, 
height or both.

Equally Space Row/Column

This feature equalizes the distance between shapes, either horizontally 
or vertically.

The Shapes Menu
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Group in Switch Shape

This feature groups selected shapes in a Switch Shape, which has the 
same features as Table Row Versions (see Table documentation). It's a 
powerful way to conditionally provide a differnt look for a specific 
element.

Move to new layer

Creates a new page layer with the currently selected shapes.

Combine Paths

Takes multiple overlapping shapes (such as a rect and an oval) and 
combines them into a single shape using the combined paths. A powerful 
to to construct complex shapes, fast.

The Shapes Menu (Continued)
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Inspector

Brings up the main inspector (covered earlier in this document).

Color Panel

Brings up the color panel.

Font Panel

Brings up the font panel.

Formatter Panel

Brings up the formatter panel, for configuring special formatting of 
substitution keys.

Keys Panel

Brings up the keys panel.

Toggle Rulers

Adds rulers to the borders of the current open document, to assist in 
precise layout.

Add Image Placeholder

Adds an empty image object to the document, which can be positioned, 
sized and configured with a substitution key.

Send Feedback

Brings up a convenient Mail panel to forward suggestions and comments 
to ReportMill engineers.

Preferences

Brings up the preferences panel, to enter or view license information.

The Tools Menu
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